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Version 7.3 Release Notes

New Features:

- Fast “TapeMode” Render:

This new feature creates a faster than real time file of complete tracks or of a marked region. All level adjustments,
fade ins, fade outs and cross-fades are included in the rendered file. This feature allows the user to name the new file
and then retrieve it from the Sound Selector for lay in to atrack or export as afile.

- MP3 Export:

In addition to the existing choices of file export formats, MP3 support has been added. User defined settings allow for
avariety of export options.

- Digital Movie Feature:

Thisfeature allows the user to digitize video and synchronize the resulting file to the time line. Most importantly,
video can now be displayed on an external monitor. There are a number of options for employing this application.
The digital movie featureis a special “keyed” option that is available through WaveFrame. Contact WaveFrame for
more information.

- Direct Support for Pro-Tools I/O through MM-EDL

Thisfeature allows the user to export WaveFrame 7 dubs to Pro-Tools through a direct call to athird party application
called MM-EDL. You must install this application separately in it's default location. MM-EDL requires a separate
license fee, purchased through WaveFrame, or directly from MM-EDL. We have included afully operational demo
version of the program in our install set. It islocated in the directory in which you unzipped the install set, in afolder
called MM-EDL

- Waveform continuous display while playing

Thisis afeature many users have asked for, but has been difficult to implement given current WaveFrame technol ogy.
As acompromise, have enabled a methodology for the system to be able to display the waveformsin “chunks’
continuously while playing. While this display is far from graphicaly pristine, it may be useful when mixing or
dubbing, to enable the user to see what is coming up to the play head in advance. Simply hold “ Shift” and pressthe
down arrow toturn it on or off. Thisfeature requires afast CPU, and may not work well when running 32 dense
tracks and digital video simultaneously.

See below for mor e detailsregarding these features



Fixes and Enhancements:
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Many problems associated with Auto Assembly have been fixed. Both “record” and “no record” assemblies
should function as expected. The only remaining known problemis the ability to record with linked (stereo)
tracks. Thisissue will be addressed shortly so please refrain from using this option.

A problem existed that could result in duplicate names with different UFN’s corrupting the database. This
condition was seen on some OMF imports and would result in both sides of a stereo file playing the same channel.
This problem has been fixed.

Many enhancements and fixes have been made to OMF imports. Problems existed where long track names and
other naming issues were resulting is inaccurate OMF tranglations or system crashes. These have all been
addressed.

OMF export has been completely redesigned and now includes sample accur ate exports. In order to create a
sample accurate export make sure that “Sample Accurate” is selected in the pull-down menu in the OMF Export
dialogue screen (this pull-down menu usually defaultsto “29.97non drop). Also, sample accurate exports require
that the “MC-10" and “Encapsulated” options be selected. YOU MUST OPEN THESE EXPORTSWITH
DIGITRANSLATOR 20 ONLY. Importsinto ProTools using Digitrandator 1.0 will not yield accurate results.
It isnormal for ProTools to create more tracks than you originally exported. Thisis because ProTools cannot
handle real time fades or asymmetrical cross-fades. The only way it can handle these situationsisto create
additional tracks that contain one part of the cross-fade. When both tracks are played back through ProTools the
result should be the same as playing back these tracks on WaveFrame. Furthermore, make sure that when
importing the session into ProTools that the “convert clip-based gain to automation” option is selected. Thiswill
ensure that any level information created in WaveFrame is properly trandated to ProTools. Although we have
tested this feature, it isimpossible for us to anticipate all the variables that might exist; therefore, we welcome any
feedback regarding the accuracy and performance of OMF export.

A problem existed with OMF exports where small clips would not translate properly. This has been fixed.

A problem existed that would not allow recordings of 16 tracks or more to be made without database errors. This
has been fixed.

A number of MM8 import problems have been fixed.
A “cleanup” bug that occurred when two or more volumes were mounted has been fixed.

A Volume mounting bug that resulted in a“bad player” message when executing “ split” or “duplicate” recordings
has been fixed.

“Current” Volume” information has been added to the lower right hand corner of the “Edit” screen. This feature
has two states. By adding the following linein “wavefrm.ini” under [session]: AutoSelectCurrentV olume=0,
the editor will automatically display the “current volume” selector, or, if no volumes are mounted a message will
so warn the user. The selector or warning message will only be displayed when starting the editor or after closing
the volume manager. By adding the following under [session]: AutoSelectCurrentVolume=1, the editor will not
prompt for current volume or warn the user that there are no volumes mounted. The system operates much as it
does now and will use the first volume it finds if there are any mounted.

A problem where the current WF7 library name was replacing the original library n ame when importing WF6
files has been fixed. The import now retains the original library name.
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A problem was discovered with the SCPID settingsin “wavefrm.ini” that was not creating files with unique file
numbers resulting in the possibility that two files could be created with the same UFN (unique file number). This
could result in conflictsin facilities that use two or more WaveFrame 7 systems and exchange files. A new
method of determining UFN’s has been implemented. Open your “wavefrm.ini” file and make surethe
following line has been added under [System]: UFN_SEED=xxxxx(xxxxx=any number you desire. We
recommend using the serial number of your dongle. Just make surethat each system uses different
numbers.)

Some .wav files were not importing properly and resulted in aa“ not arecognized file format” message. This has
been fixed and all .wav files should now import and export properly.

When installing WaveFrame 7 on a new computer remember to do the following: Go to the “Sound Preferences”
menu, open the SDII tab and click on “factory reset”. Thiswill add the .omf preference to the list of recognized
SDII files. Thisextension iscritical to accurately importing many OMF trandlations.

Add information regarding inclusion of sd2 file types into the Mac Drive program asfollows. filetype: sd2f; file
creator: sd2a; windows file name: sd2.

Rewind shuttle (with the“7” key) no longer crashes the system when a Quick Time movie is synchronized to the
timeline. See below for digital video optioms.



Using the Render Feature

In WaveFrame, asin many other systems, tracks are usually composed of many sound files. The whole sound file
may be used in atrack or only asmall portion of that file may be used in the track. The “render feature” selects only
theused portions of al the filesthat exist in atrack or in amarked region and creates a new “contiguous” file that
may be laid into atrack or exported asafile. All level information including fade-ins, fade-outs and cross-fades are
rendered into the final file. This process creates the new file many times faster than real time. Entire tracks
(including all members of a group) or “marked regions’ may be selected for rendering.

Under the “ Create” menu, you will find two new options. “Render Whole Tracks’ and “Render Marked Regions.
Selecting “Render Whole Tracks” will create arender that starts with the first sound in atrack and ends with the last
sound in atrack. If thetrack is part of agroup, all members of the group will be rendered as separate files. Selecting
“Render Marked Regions’ will create arender that starts with the beginning of a mark and ends at the end of a marked
region. Multiple tracks may be selected when rendering marked regions. The mark may start or end at the beginning
or end of sound files or may start or end anywhere in-between. Only the portion of the track that isincluded in the
marked areawill be included in the render.

IMPORTANT NOTE: YOU MUST “SAVE” YOUR SESSION PRIOR TO EXECUTING A RENDER. IF
YOU HAVE MADE ANY CHANGESAND NOT SAVED, THE RENDER WILL NOT INCLUDE THE NEW
CHANGESAND WILL REFLECT THE TRACKSASOF THE LAST SAVE.

Selecting either menu option will open the following “Render Dialogue Box”.
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ApplyMomaTo: _ Selected | Al ClearSel | Clemraul |
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Explanation of Render Dialogue Box:

Destination Volume: Use this drop down menu to select the mounted volume that the rendered file will be added to.

Space Available;

Indicates amount of space left on selected volume.

Space Required: Indicates amount of space necessary for the rendered file(s).

Start Time: If amarked areais selected for render, this box will indicate the start of the mark in the
timeline. If “Render Whole Tracks’ is selected, the words “Entire Track” will appear.

End Time: If amarked areais selected for render, this box will indicate the end of the mark in the
timeline. If “Render Whole Tracks’ is selected, the words “Entire Track will appear.

File Window: Thisareais used to list the tracks or regions selected to be rendered.

Enter Render

File Name: Type in the desired name for the new file(s) to be created.

Use Track Name:

Selecting this option will automatically assign the existing track name to the new file.

Append: When you select the“Use Track Name” option, this feature allows the user to add a user
defined name (any name typed into the “ Enter Render File Name” field) to be added to the
beginning of the track name.

Apply Name To: Use “Selected” to apply the name changes only to those tracks or regions that you have
selected in the File Window. Or, use “All”
to apply these changesto all tracks and regions displayed.

Cancel: Use this button, to cancel any render operation.

Render: Use this button to execute the render(s)

Clicking on the “Render” button will start the render for the track(s) or selected region(s). The Progress Bar will be
activated showing the progress of the render(s). Upon completion of all the renders, a“Render Completed: Would
you liketo export the new sound files?” message will appear. If you select “No”, the dialogue box will disappear
and the resulting files can be located in the Sound Selector. If you select “Yes’, the Sound Export dia ogue box will
appear alowing the user to export the rendered filesin aformat and to alocation of their choosing. Renders use the
current “Library Name”. If you have alarge number of rendersto locate, create and use a new library name prior to
the renders. This name can then be used to search the Sound Selector for all completed renders.



M P3 File Format Export

In addition to the existing export formats (AIFF, WAV, BWF, WF7, SD2), version 7.3 now supports file conversion
and export to the MP3 format. Open the “Export” dialogue box and select MP3. Next to the “MP3” radio buttonisa
“Settings” icon. Click on thisicon to open the “ Settings’ dialogue box for the following options:

Encoder Type

Select “Lame”. This| the only encoder supported

Mode

Offersthree choices: CBS, ABR, and VBR. CBR (constant bit rate) is the default option
Bitrate

Use this option to set the desired bitrate in kbps. Use 128kbps to produce CD quality stereo files and 64kbps to
produce CD quality mono files.

Quality

Therangeis between “0” and “9” with “0” being the highest quality



Digital Movie Option

Thisfeature allows the user to digitize video and synchronize the resulting file to thetime line. Most importantly,
video can now be displayed on an external monitor or recorded on aVCR. Thisisaspecia “keyed” featurethat is
available through WaveFrame. Contact WaveFrame for more information regarding this feature

Many changes have been made to the digital video interface since the last release. This version of the movie feature
has been optimized for use with the Media 100 iFinish capture and playback card. The advantages of this card
include: high quality image playback, very tight picture to sound sync, relatively small file size, and ease of picture
capture and use. The disadvantages of using this card include: relatively high cost of card, hasto use itsown
proprietary codec, and some amount of jump back between the “play” mode and “stop” mode when using the numeric
keypad. The other method of playback through a TV monitor utilizes the Matrox “Parhelia’ card. Thisisavery
powerful graphics card with the following advantages. relatively low cost, plays back a variety of formats, extremely
smooth transport control of picture and sound, and can be used to display any desktop window including the
Waveframe mixer and/or plugins. The disadvantages of this card include: need a separate video capture system,
video quality not as high as using the MedialQ0 card, video playback may contain motion artifacts that may affect
sync perception.

Both methods of video capture and playback are described in detail below:

Media 100 iFinish Quick Start Guide

Installing iFinish Software and Hardware:

1. Ingtal theiFinish hardware in afree PCI dlot.

2. Select cancdl if the “found new hardware wizard” comes up.

3. InserttheiFinish CD. Theinstaller should start automatically. If it doesn’t, run “setup.exe” from the CD.

4. Select Install fromthelist of options.

5. Select iFinish from the list of options.

6. Follow the onscreen instructions to install the software. Y ou will need to enter your hardware key at this
time.

7. After iFinish installation, you will be prompted to install Inscriber CG/Title Motion. Select OK to install

Inscriber CG/Title Motion.

8. Follow the onscreen instructions.

9. Whenthe Title Motion installer asks what components to install, uncheck all boxes and continue.

10. You will need to restart your computer when installation is complete.

11. Upon restart the “found new hardware wizard” should detect and install the iFinish hardware. Y ou may need
to restart your computer once again after installation.



Configuring iFinish Software:

1. Under the “Edit” menu, select “Hardware Settings’. The Hardware Settings menu has options for the Video
and Audio inputs as well as machine control settings. The video input source is selected here as well
(composite, component, etc.)

Hardware Settings il
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Digital Channel In
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(The hardware settings menu.)

Preparing to digitize:

Creating a New Project:

1. Select “New Project” under the “File” Menu.

2. Enter afile name and location for this project. We recommend something descriptive and generic such as
“WFmovies'. We also recommend saving the project on the system drive (My Documents for example).

* WEMovies _ ||:| |£|
|T I MName | Date |
Hr WPMovies.M1hbn Tue, Mow 18, 2003, 11:10:1...
(The project window.)

3. The“Media Settings” menu should open automatically.

4. Select which drive you want the media recorded to by clicking the“V”, “A”, “FX”, and “G” columns for the
selected drive. Ideally, this should be a drive other than the system drive or the sound drive. The program
will automatically create afolder with your project name on the drive you selected.

5. You can also select the quality rate from this menu.
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(The Media Settings menu.)

Creating a New Bin:

1. Under the “File” menu, select “New Bin”.
2. Select the bin and under the “File” menu, select “ Save Bin As’. It isrecommended that you save the bin in
the same place you saved the project file. Y ou must create a bin before you can digitize media.
1 (=1}
|Eleaver
(The bin window.)
Opening iFinish:

We recommend that you create a shortcut on your desktop directly to the project file you just created. From now
on you would open iFinish only from this shortcut, rather than the one created when the program was installed.
Furthermore, you should always save the project every time you exit the programto keep it up to date with the
media clips on your hard drive.

Digitizing Media:

1. Open the digitizing window under the “Tools” menu, by selecting “Edit Suite Mode>Digitize”. Or if the Edit
Suite window is aready open, select “Digitize” from the dropdown list.

2. Select what you want to digitize by checking the boxes for the Video stream and two Audio streams.

3. Enter aReel Name and a File Name. To keep things simple we recommend using the same name in both
places. The name you type for “reel” determines what the actual video files name will be on the computer,
the “clip” name determines what you will see when managing your mediain the bin.

4, Click start to begin digitizing.

5. Click stop when you are finished.
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(The Edit Suite: Digitize Window.)

Managing Media:

We recommend you do all media management from within iFinish. iFinish creates multiple files for
each clip you digitize, one for the video and one for each track of audio. After digitizing iscomplete, aclip
will appear in the bin window. Thisclip isashortcut to the files located on the media drive you specified
earlier. It isbecause of thisthat we recommend you delete and manage your clips through the iFinish
software. It becomes especially important when managing media through iFinish to always save the project
when you exit the program to keep it up to date with the media clips on your hard drive.

Playing a Clip.
1. Select the bin window.
2. Double-click the clips thumbnail. The Edit Suite window will automatically switch to “Edit Clip” mode.

3. Usethetransport controls and the timeline to scrub and view your clip.
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(The Edit Suite: Edit Clip window.)

Deleting a Clip:

1. Select the bin window.

2. Right-click the clip you wish to delete.

3. Select “Delete Clip and Media’ from the drop down list. Merely selecting a clip and pressing delete will

erase the clip from the Bin Window but will not remove the actual mediafile from your computer. To
actually remove the file and thereby free hard disk space, you must select “ Delete Clip and Media’.

_lojx]

IEeaver

Undo Ctrl+Z
— RedoCut Ctrl+Alt+Z

Cut Clip Ctrl+X

Copy Clip Ctrl+C

Paste Ctrl+v

Clear Clip

Duplicate Clip

Delete Clip and Media

Delete Media

Batch Digitize...

Batch Digitize Selected...

(Deleting a clip and it’s associated media.)
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Exporting a Clip:
As mentioned previously, iFinish always saves aclip’s media files separately, one file for video and one

file for each audio track. On top of this, Media 100 doesn’t use a QuickTime wrapper in its native file
format. Dueto this nature, a captured clip played back through QuickTime will not play audio. To counter
this, you can first export the clip as a self-contained file with a QuickTime wrapper, or even recompress and
convert it to another file format. (WARNING: While both native and self-contained movies will play back
through WaveFrame using the iFinish hardware, movies that are recompressed will not.)

1. Double click the clip’s thumbnail in the bin window. Thiswill open the Edit Suite window.

2. Fromthe “File’ menu, select “Export from Edit Suite.” The Export Window will open.

3. Fromthelist at the bottom select the “ Self-Contained Movie” radio button. (If you wish to export to another
format select the radio button in front of the open box at the bottom and choose your format.)

4. Select what you want to export (video and audio).

5. “Selection:” should be set to “ Source”.

6. Enter afile name and location and click export.

(The export window.)
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Playing Back Though WaveFrame:
WARNING: TheWaveFrame and theiFinish softwar e cannot be opened at the sametime.
When you have completed digitizing and media management, completely shut down iFinish
before attempting to start WaveFrame.

Importing a Native Medial00 Video File:

1. Under the WaveFrame “Options’ menu, select “Open Movi€”.

2. Navigate to the appropriate mediafolder.

3. Select “al files’ from the “file type” drop down list.

4. Thevideo file will contain the reel name you typed when digitizing as well as a Capital “V” and the data rate
you digitized at.

Select the appropriate file and click on “open.”

If the digitized video contains a“burned” window, align the WaveFrame timeline with the movie

“window” time code and then select “Movie Locked To Playhead”. Thiswill lock the two systems together.
Each time a WaveFrame project is recalled the associated movie will also be opened and locked to the
playhead.

o o

Importing a Self-Contained Movie (.mov) File:
1. Under the WaveFrame “Options’ menu, select “Open Movie”.
2. Navigate to the media folder, select the file, and click on “open”.
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M atr ox Parhelia Quick Start Guide

The Parheliais avery powerful triple-head (capable of powering 3 separate computer monitors) display
card that can be used as an alternative to Media 100 for showing video on an external client monitor. Even
though Parheliais atriple head card, limitations in the design only allow you to use one computer monitor
and one TV monitor with independent resolutions. Therefore if you want a dual head workstation, plus an
independent TV display, you will need a secondary PCI video card (more on that later.)

Setting up the Parhelia

1. Follow the Parhelia’s installation instructions, making sure to hook up your primary Computer monitor to
Parhelia s first head and the TV monitor to the second head, going through the 'y’ cable’s number 1 output.

2. Install the latest drivers and the Matrox Powerdesk. (Microsoft’s Dot Net framework must be downloaded
and installed before Matrox’s installation will work.)

3. Set up the Matrox Powerdesk asfollows:
Under the Multi-Display Setup menu select: “2 Displays, Independent Mode (with features)”.
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Select “Display Properties’
Click on Screen 2 and select “Extend my Windows desktop onto this monitor.”
Select aresolution comparable to the one on your primary display. Click OK to return to the PowerDesk.

Under the Video Playback Settings menu, select “Use Video Overlay” Don't select “ PureVideo/DVD
Max”. Close the PowerDesk and restart your computer if it asks you to.

Y ou should now see your desktop extending all the way across both your computer monitor and your TV display.

4. Load your movie through WaveFrame and now you can position it anywhere on the computer or TV screen.
Y ou can stretch the Movie to fill the TV screen and adjust for over scan and TV size in the PowerDesk menu
under the Monitor Adjustments menu.

WARNING: You may experience choppiness or even crashesif the Quicktime window is overlapped by any other
window open on your computer during playback. For that reason we suggest you refrain from moving or stretching
the Movie window out of the TV display.
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Setting up the Parhelia for use with a Secondary PCI Video Card

If you want a dual-head display aswell as your TV display you must use a secondary PCI graphics adaptor
to drive the second computer monitor. We recommend the Matrox G450 PCI as a good choice however
others may work as well (We have only tested this configuration with the G450).

Install the Parhelia as described above, following step 1 in the previous section.

Install the Matrox G450.

Configure the computer’s bios as Matrox recommends in their installation guide. Make sure that the
“primary display” optionis set for AGP and NOT PCI.

Install the latest Parhelia drivers and Power Desk.

Install the latest G450 drivers (you don’t need the extra multi-display support.)

Configure the Power Desk using the same options as above.

Under Display Properties select monitor 2 and check “Extend my Windows desktop onto this monitor.”
Follow the same procedure for monitor 3.

Position the onscreen monitors to suit your needs and setup.

wph e
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A Word About Video Capture

WaveFrame can play back any file format that Quicktime can. Any Quicktime format can be displayed on the TV,
however some are better than others for performance and stability. These results may vary depending on computer
configuration and components.

DV:

DV is perhaps the easiest format for use with WaveFrame. Both files created on Mac’s and PC’ s will play back in
Quicktime easily as long as the Quicktime player is associated with the DV format. Another handy function isthe
“High Quality Playback” setting located on the Mixer Menu bar under Settings. This setting limitsaDV file's
playback resolution if you notice poor performance when playing back with high quality DV clips. DV can be
captured using any transcoder connected to a 1394 card on either aMac or PC.

MJPG:

MJPG is another good option for playback in Quicktime. Many capture boards have the ability to capture video in
real-time to the MJPG format. Unfortunately you will probably have to capture your video at half resolution
(320x240) to get good performance out of your WaveFrame. We recommend the Hauppauge VCB (approx. $75) as a
good, low cost board for capturing MJPG material.

Using MM-EDL to Import and Export Projects from and to Pro-Tools

MM-EDL isathird party application which can read and write Pro-Tools 5 projects, aswell as OMF, OPEN TL and
WaveFrame 6. Included in your WaveFrame 7.3 install package is a fully functioning demo version of MMEDL,
which works completely, except that it adds beepsto all audio it is processing, enabling you to install and use it to see
if it will work for you. In order to unlock the program for actual use, you must obtain alicense from www.mm-
edl.com, or call WaveFrame support at 503-419-3911.

Since MM-EdI can not read or write WaveFrame 7 files, we use OPEN-TL as a“go between”. On the OUTgoing side
(exporting from WaveFrame 7 TO ProTools), thisis done transparently by the WaveFrame 7.3 Project Browser.
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Simply open Project Browser, select a DUB version of a project, then choose “Pro-ToolsviaMM-EDL”. This dialog

will be displayed:
Hit “OK” and the OPEN-TL export dialog will display. Make the desired selections and after the TL export is
complete, MM-EDL will open automatically, with your project ready for export to ProTools. See the MM-EDL Users
Manual for details regarding the ProT ools parameters, operation of MM-EDL and procedure for creating an OPENTL
project for IMPO$SRTING a projectfrom ProTools to WaveFrame 7.

RELEASE NOTESFROM THE PREVIOUSVERSION:

New Features & Updatesin Version 7.2

Enhanced OMF Capabilities:

A number of exciting enhancements and fixes have been made to OMF import/export, including:
Greater compatibility with ProTools systems! Level information is now included in an OMF
composition exported from WaveFrame/7 and will be imported into a ProTools session as
automation data. This feature greatly improves compatibility between the two platforms.
Level data such as afade in and fade out, changesin level between the start and end of an event
are now supported and will show up as automation data. Y ou must use Digitransglator 2.0in
order totranslatethisinformation. Please note that this version of OMF has been tested with
positive results on ProTools versions 5.1.3 and 5.3.1. Some older version of ProTools and
ProTools Free version 5.0.1 will ignore specific gain and pan information and will only
trandlate overall clip gain. When importing through Digitranglator 2.0 make sure the following
option in selected in the pull down menu: “convert gain to automation”. In order to export
level changes along with the OMF composition make sure that the “MC10” box is checked in
the WaveFrame/7 OMF export dialogue window. “Legacy” mode will export the
WaveFrame/7 project but without specific level information. Unfortunately, Digidesign does
not support the export of level information from a ProTools session and, therefore, thislevel
information cannot be imported into a WaveFrame/7 session (or any other workstation for that
matter).

Naming issues that were causing the WaveFrame/7 application to crash have been fixed.
Support has been added for importing session from Final Cut Pro.

48K and 44.1K frame rates are now supported to allow imports from sample based editing
systems (including Final Cut Pro). In the past these imports would result in a system crash.
Several fixes were made for AVID 10.5 where references to gain and eq were crashing the
system.

Implemented new “select” option for AVID 10.6.

Fixed bad sound references that resulted in no file or the wrong file being placed in atrack.
Now all missing sounds are found.

Several enhancements were made importing/exporting ProTools sessions. OMF imports made
from Digitranslator 1.0 and 2.0 are far more reliable that they have been in the past. Animport
problem that previously resulted in a system crash has been fixed.




19

An option has been added that will automatically apply aramp (default cross-fade) to all-
adjacent edits that contain enough sound (handles) to make this possible. In the past, imports
into WaveFrame resulted in 90-degree “butt” edits that often would cause audible clicks as the
playhead past over them. This feature adds a default ramp similar to those ramps that are
created when any edit on aclip is made.

Multi-Board Support

As of thisrelease, WaveFrame/7 now supports the use of multiple Mykerinos cards (up to three). A
multiple card system offers increased DSP for the use of more plug-ins, as well as expanding the number of
I/0. For example, two cards with ADAT daughter boards will provide not only increased plug-in power,
but also alow for an 1/0O configuration of up to thirty-two channels. For more information, please refer to
the section on multi-board support later in this document.

Record Processing Time

Thetime it takes to process a recording with waveform turned off has been greatly reduced. This
processing time is no longer dependent upon the number of tracksin “record” or the length of the recording.
Under normal circumstances, it should only take afew seconds to see the resulting recording in the track.
Recording with waveform turned on has also been improved; however, the processing time is dependent
upon the number and length of the tracks. Speeding up the record processing time is an on-going project
and we intend to improve its performance with every release.

Faster ADR Re-cue

Thetimeit takes to re-cue the playhead back to the beginning of a marked recording in ADR has been
significantly reduced and should be close to WF6 performance. In past versions, if arecording was aborted
(by pressing the record button again before the playhead reached the end of the marked area) it would take
several seconds for the playhead to reposition itself and start recording again.

User Defined Project “ Start” and “Length” Times
It isnow possible for the user to set the default project “ start” and “length” times as defined in Create Reel.
In the past, this setting was not user-definable and the default start time was 01:00:00:00 and the default end
time was 01:15:00:00. If you desire to change this setting add the following lines to the [ SESSION] section
of “wavefrm.ini” (note: entriesin wavefrm.ini are case sensitive, so enter the line exactly as shown):
DefaultReel Start=“00:58:30:00” (or time of your choice)
DefaultReel Length= " 02:00:00:00" (or length of your choice)
You must “save” the new entries in the waveframe.ini file and re-launch WaveFrame in order for the
changes to take place. Using the above example, every time you define areel the start time will
automatically be set to 00:58:30:00 and the end time will be set to 02:58:30:00. If you choose not to enter a
new value in “waveframe.ini”, the old default timeswill be used to set the start and end times of the project.

Large Font Friendlier

Those users who desire a larger font size may select this option by right clicking on the desktop, select properties, and
then select the settingstab. Click on the advanced setting icon and change the font size to “large” and click ok. You
will have to re-boot for the settings to take place. Thiswill set the application so that the fonts are displayed at 125%
of normal.
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AES-31 Now I mplemented

Asof thisrelease, the AES-31 option has been implemented. Preliminary testing has confirmed that both
the import and export functions are working as expected. Inthat thisisarelatively new approach to system
project interchange, more refinement to this feature may be necessary. Please report your findings (both
good and bad) to WaveFrame support.

Focus | ssues

Anytime the view current or autoview dial ogue box appears (such as after arecording or creating aloop or
effect), the focus now defaultsto the “name” field. In the past, the user had to tab to thisfield in order to
enter data. Also, after “laying-in” asound from the Sound Selector, focus is automatically set to the track
window. This makes laying-in a series of sounds much faster and easier.

Sound Export Directly from the Track Window

This new feature allows the user to export sounds directly from the track window. For example, a series
of recordings can be exported to any user-defined format or location without having to first locate them
in the Sound Selector. A new menu item has been added to the Utilities menu called Export Current.
Sounds may be selected for export in one of two ways. First, by placing the play-head directly over a
sound in the track that has focus (using this method will also include any siblings of the selected sound).
Second, by using a marked area to define many sounds within atrack and/or sounds across multiple
tracks. Upon selecting the “export current” menu item, the Sound Export dialogue box will appear. Itis
here that you may select the file type, bit depth, and destination (sample rate conversion coming soon).
Remember that when you select sounds for export from the track window you are exporting the entire
sound and not just the areathat isvisible in the track window. If asound clip contains any edits, it will
be necessary to create a new contiguous file by re-recording the material. Y ou may accomplish this by
feeding the source into a new track for re-recording or by selecting multiple tracks and using the “ split”
or “duplicate” record feature.

Sound Export After Recording

It is now possible to export a new recording immediately after it is made. Holding the control key down
while mouse clicking on the “Modify” or “Cancel” buttons of the Sound Info Viewer dialogue box will
bring up the Sound Export dialogue box (alternately, hold the “control” key and push “enter”). Itishere
that you may select the file type, bit depth, and destination (sample rate conversion coming soon). For
conventional recordings using the ADR or Editor screen make sure that the “ Autoview” option is
checked under Recording Preferences. Thiswill bring up the Sound Info Viewer dialogue box after a
recording is stopped. Creating an “Effect” or “Loop” automatically brings up this dialogue box. This
new feature is useful for quickly creating a continuous file and exporting it to a user defined destination.
For example, if you have a sequence with many edits and need to make afile for client approval, use
Create: Effect. When the Sound Info Viewer dialogue box appears, name the file, and then press the
control key while clicking on the “Modify” button (or push the “enter” button while holding the
“control” key). The Sound Export dialogue box will then appear where you can select the file type, bit
depth, and destination.

Project Export Enhancements
The Project Export dialogue has been enhanced in anumber of ways. As before, you can navigate to an
existing folder or, now, create a new folder for your project export.
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To create a new folder, navigate to the desired location and click on “create new folder”, enter a name and press
“enter”. A new folder will be created and your project information will appear at that location. A dialogue will
then appear asking you if you want to export sounds. If you answer “yes’ the project sounds dialogue will appear
and you can select the destination of the project sounds. There are two options.  Firgt, if you check the “drive
path” option, the default location will be the same location that you chose for “ project information” export (or, you
can click on the “browse” button to select a new location). When you export the selected sounds, a folder will be
created at the desired location called “sounds’ that will contain the exported sound files. At alater time, you can
“create” and “mount” thisfolder asa*“volume’ through the volume manager. Alternatively, if you check the
“mounted volume” option, you can select an existing volume or create a new volume by clicking on the “volume
manager” button. Here, you can create a new volume or mount and dismount existing volumes. After determining
the destination, select the sounds for export and then click on the “export” button to send your sounds to that
location.

Playhead L ocking

It is now possible to lock the playhead in any position of the transport screen. Free the play-head by
making sure that the “ playhead locked” option (under the Options menu) is not checked. Place the
playhead in the desired position on the screen. Open the Options menu and while holding the “ control”
key, click on playhead locked. To return to the default (playhead centered), toggle playhead locked off
and then on again in the Option menu.
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leed InthisVersion

A bug that prevented the transport from immediately going into reverse play when atrack was
placed in record ready has been fixed. The transport should now operate asintended in al
transport modes.

An ADR praoblem that created a bogus file that extended to the end of atrack if arecording was
stopped before the playhead reached the marked area has been fixed.

All known OMF problems that resulted in a system crash have been fixed.

The file import dialogue box is no longer hidden behind the Sound Selector. The window now
gets priority when it is opened.

Selecting new reel under the File menu now focuses on the correct field,

Create a“dub” version in the track rack no longer causes a“Primitive Error” and should now
function correctly.

Numerous fixes have been made to AES-31 including fixing track limits and naming issues.

A problem importing projects or filesfrom a“read only” volume (such as a CD) has been fixed.
Now project information can be imported directly into the system without first copying it to the
desktop and changing its attributes.

Some sync issues pertaining to the Movie feature have been fixed. The movie should stay in
sync with the main track window under all circumstances. We are actively working on this
feature and should have a complete solution by the next release.

A record problem that resulted from auditioning sounds in the Sound Selector has been fixed.
An auto-punch recording with a mark would not go into input resulting in a silent recording.

MULTI-BOARD SETUP

Note: Asof thiswriting, the ADAT daughter board isthe only board that is currently supported for multi-
board. Other boardswill be available shortly

In order to enable multi-board operation, all Mykerinos cards in your PC haveto bein

interconnected together using a special HDTDM ribbon cable. This cable hasto be plugged into the multi-
pin connectors located on the top edge of the I/O daughter cards. Please contact your WaveFrame dealer
for information on how to order thisHDTDM ribbon cable. For the multi-board to function, the HDTDM
(High Definition Time Domain Multiplex) bus has been introduced which is the internal connection
between the Mykerinos boards, the Trimedia DSP’ s and the physical 1/0’s. There are 64 internal shots
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available to route 64 inputs signals to the mixer, and there are also 64 internal slotsto route the output
signals of the mixer to the physical 1/0s. The 64 links are shared between the physical I/0s AND the
internal send/return buses used for auxiliary sends of the mixer. So you have to decide on how to distribute
the 64 dlots between physical 1/0s and internal send/return buses. Thisis donein the WaveFrame VS3
control panel.
For the multi-board application a predefined method is used to distribute the available DSP s on different
areas of the mixer. The following areas are defined:

FX IN: Thisareaisreserved for plug-ins that are inserted in the input strips of the mixer

MIXER: Thisisthe mixer itself containing the routing, level control, and panning.

FX OUT: Thisareaisreserved for the plug-ins inserted on the output strips (surround, stereo
mixes, monitor, and aux buses).

In the WaveFrame V S3 control panel you can choose between two options on how to distribute the
available DSP between the three areas. They are called Privilege I nput Effects and Privilege Output
Effects. Thiswill determine how much DSP power is available for plug-ins on input and output strips. The
following figures show how they affect the DSP allocation depending on the number of boards in your
system. (Please note that as of thiswriting the maximum number of boards tested and confirmed working is
two).

DSP allocation with 2 boards

Privilegeinput effects

Board #1 Board #2
FXIN MIXER/FX OUT

Privilege output effects

Board #1 Board #2
FX IN/MIXER FX OUT

DSP allocation with 3 boards

Privilege input effects

Board #1 Board #2 Board #3
FX IN FX IN MIXER/FX OUT
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Privilege output effects

Board #1 Board #2 Board #3
FXIN MIXER FX OUT

The WaveFrame VS3 Control Panel

A new control panel that allows you to do all the adjustments as described above has replaced the Board
Info application. The main goal of the control panel isto define the global setup of our specific Mykerinos
hardware and your physical 1/0s. On every Mykerinos board you could have different I/0Os (ADAT,
MADI, AESEBU, TDIF) and there might be more physical I/Os than the software can actually deal with.
So thisisthe way to tell WaveFrame which physical inputsto use.

The control panel islaunched by opening the Control panel window (Start Menu>Control panels)

And then double clicking the control panel called VS3. The figure on the next page shows the new control
panel.
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L egend:
1 Thisisthe graphical representation of the 64 input slots. The slots are shown in-groups of
eight inputs. To change the assignments of slots by hand, you can drag the physical inputs

of the Mykerinos boards shown in the lower part of the control panel to any slot with the
mouse.
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2. Thisisthe graphical representation of the 64 output slots. The slots are shown in-groups of
eight outputs. To change the assignments of slots by hand, you can drag the slots to the
physical outputs of the Mykerinos boards shown in the lower part of the control panel with

the mouse.

3. Use this dropdown menu to select the DSP allocation (Privilege input or output effects).

4. Use this dropdown menu to select the number of send/return buses. The buses are selected
in-groups of eight and automatically fill up the topmost slots.

5. The Auto Routing button automatically fills up the available slots with the physical inputs

available in the system, starting with the I/O’ s of the top most Mykerinos board. On

smaller setups thiswill most likely be al you need to do to configure your systemin a

useful way after you have selected the number of send/return buses.

The Reset Routing button deletes all assignments of 1/O’ s to the input and output slots.

With this check box at the left side you can activate or deactivate individual Mykerinos

boards for use in your multi board system. If aboard is deactivated, it’s physical 1/0 and

DSP will not be available for WaveFrame.

8. For each Mykerinos board present in your system you will see an icon showing the serial
number and the type of 1/0 present.

0. Use this radio button to select the board that will be the “Master Board” of the system.
This s the board whose time code/video connections are used to synchronize your
WaveFrame system. Also, its headphone connection is the one to use for monitor output.

No

If thereis only one Mykerinos board in the system, the HDTDM busis not used, and WaveFrameis running
in mono-board mode. In this case, all the settings done in the control panel are disregarded, and the
send/return buses are alocated as needed by the mixer. However, after the installation of WaveFrame, you
should open this panel, click the Auto Routing button and the close the control panel. Currently, the only
I/O option that is supported by multi-board isADAT. Other 1/0 optionswill be supported shortly.

ProTools to WaveFrame/7

The following instruction should be used in preparing a ProTools session for import into WaveFrame/7 via
Digitrandator. 1.0. Please note that ProTools does not allow level changes to be exported and all fade ins/outs and
dissolves will be rendered.
1- Openyour ProTools session.
2- Stereo tracks must be split into mono tracks. Select any stereo tracks, open the “File” menu and select
“split selected tracksinto mono”.
3- Open “File” menu and select “save session copy in.” (Digitranslator 1.0 only recognizes ProTools 5.0
for export. Therefore, your session must be converted accordingly).
4-  When the dialogue appears :
Select the location to save the sessionin
Name the selection copy
Choose the Session Format (must be selected to “ ProT ools 5 Session”)
Select 16bit (Avid OMF tranglation does not support 24bit material)
Set the appropriate fame rate
Click on “Save’.
“would you like to continue” message will appear. Click on “yes’.
6- Open“Digitrandator”
7- Selectthe “ProToolsto Omf” option located in the center of the dialogue box
8- Click on“Open” and navigate to your saved 5.0 session located in the left portion of the dialogue box
9- Choose the “ create embedded OM FI media” option located in the right hand portion of the
Screen
10- Check the box marked: “quantize editsto frame boarders’
11- Click on*“Save’

>oukwdpE
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Open the resulting OMF file in WaveFrame/7 as outlined

Known issues
The following are known bugs and issues that we are currently working on:

Set Fill and Define & Configure Tone auditioning is repositioning the movie back to the start.
Playing the tracks again will re-sync the movie.

A right-mouse-click scrub with the movie window open may produce an inaccurate sonic
quality, sort of warbly or jumpy. Thiswill be addressed in the next release.

When amovieis open, pressing the fast forward key (9) or rewind key (7) may crash the
system.

Chase (gray) mode does not lock when there are no soundsin any tracks. If asoundislaidin
to at least one track then the system locks. Thiswill be fixed later.

If the time code source is stopped in gray mode, you cannot Save or switch reels until the
“stop” button is pressed. Hold the “control” key while clicking Save to override this.

If two or more tracks are assigned to the same output (i.e. DO1) tracks may mute. Also,
zooming in and out of atrack may also cause atrack to mute. Clicking on one track and then
the other will usually clear this problem and un-mute the track. Thiswill be fixed soon.
Creating aloop smaller than 15 frames fails to record.

Performing a create loop, create effect, or duplicate record resets the mixer faders.
Auto-assembly using machine control will sometimesfail. Thisis being addressed.

Recording of stereo filesin auto assembly is currently not supported and may crash the system.
Thisisbeing addressed.

When atrack input is set to MO3 or higher, executing arecord will crash the system.

A project name that includes any illegal characters (. /, etc.) may not automatically re-open the
next time WaveFrame is launched. The project is NOT corrupted. Manually reopen the project
viathe Project Selector. “Rename” or “Save AS’ the project to prevent any problems. This
problem will be addressed in afuture release.

The Print application may display an error when switching to and from it via the Utilities menu.
Thisisnot fatal and you may just have to re-launch Print or Editor. Thiswill be addressed in a
future release.

Some DirectX plug-ins may not work properly in the mixer. We will be investigating these
issues.

Avoid using the ALT-mute (hard mute) function to disable a track (mute button turns black;
track audio is not heard). A bug existsthat will not re-enable (unmute) the track’s playback
engine. Wewill addressthisin afuture update

Warnings, Cautions, & Misc. Notes

Items that are not yet operationa include:
Available Space, Record Time and afew other miscellaneous features. Most of these items
have been disabled and will appear grayed-out in the menu.
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We are currently working on the following areas:

Improving the mixer and implementing automation
Full digital video support

Sampl e rate conversion and MP3 support
Speeding up the record processing time

WaveFrame/7 uses special drivers for the Mykerinos board. This version currently requires
version 4.0.22 of the VS3 drivers. Our instalation will automaticaly handle this, including
checking before overwriting newer driver versions.

With thisversion you can also run Pyramix/FrameWor ks v4.0 Release (only) on your WF/7
system. |f you are already running thisversion, you can run the WF/7 install with no problem.

Y ou should not install and run Pyramix or FrameWorks/DX version 3.2 release or v4 beta versions
on the same system as WF/7 7.20. Doing so may render the system inoperable or cause other
unknown problems that could affect your work.

VERY IMPORTANT: If Pyramix or FrameWorks/DX isinstalled AFTER WaveFrame/7, a
registry setting called IdleThread is modified that may crash the WF Editor when right-click
scrubbing. If you need to install both applications, we recommended you install FrameWorks
BEFORE WF7. Thiswill allow the WF7 installation to reset this registry setting. If you have
problems, or have already installed FrameWorks after WF7, please find the file
‘REG_Patch_for_ldleThreadTo0.reg ‘ in the Misc folder of the installation set and double-click it.
Thiswill merge correct information into the Windows registry and update the IdleThread value
back to 0.

Various sound and project import and export routines in WF7 require MacDrive 4.04 or later. Thisisa
Macintosh file translation utility by MediaFour (www.mediafour.com). Not installing this on your system
will cause various sound file inconsistencies in these routines. Be sure your MacDrive 4 & 5 CD settings
are as noted in the Sound Files & Volumes section of the Getting Started guide.

In general, it is best to avoid using the ‘ space’ character asthe first or last character in a project name from
any platform, including OMF, OpenTL and WF7. Thiswould include Episode, Reel and Track namesin
WaveFrame/7 as well.

Use of the Spread command in the Name column of the Sound Selector is not allowed and is not avalid
operation since Windows does not allow duplicate file names. For now, doing so warns the user that the
file's name already exists, but appears to rename the first onein the Spread list. Oncethetable isrefreshed,
it is clear this sound was not renamed.

No event or sound file may appear when recording into the last track of the layout when using the ADR
beeps (since beeps use this last player/voice). Avoid recording into the last track, as this behavior may not
change.

Although WF6 project import warns and halts when the destination drive gets filled to capacity, the system
will not let you cancel or exit out of thedialog. You'll need to use the Windows Task Manager to close all
WF apps and relaunch.

Avoid accessing and doing a WF6 formats when the WF6 Import or Export dialogs are opened. Doing so
can cause some problems, especially if you intend to be importing before the format. Users should always
use care when formatting drives.
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The new WF6 Import dialog does not yet offer imports into an existing WF7 project or the ability to
overwrite aproject or tracks viare-import. If you need to re-import a project, you will need to give the
destination WF7 project a unique name and later move tracks between projects as needed.

If Cleanup stops with a message saying “cleanup can't continue: view log?’, the database most likely has
errors or missing files. Viewing the cleanup log will show something like the following for the files that
can't be found and deleted: SHfile Operation #0 (then file name). These listed files are then not deleted
even though they arein thelist. If you seethis, test your database for errors under

System..Test Main Database; then use Rebuild Main Database and/or Dismount All in V olume Manager
and Refresh and re-mount all your volumes

Merging, the Mykerinos board manufacturer, has identified the cause of possible start-up crashes and
DSP(0) errors on certain specific PC systems. These seem to be related to the use of PCl “special cycles’
by certain motherboards under Windows 2000. To avoid these PCI “specia cycles’, a new VS3 Windows
registry key has been created called “IdleThread”. This key’s value is set it to O by default upon WF7
installation, but can be changed to 1 if this crash is seen. Find the file cadled
‘REG_Patch_for_DSPO_error.reg’ in the Misc folder of the installation set and double-click it. This will
merge this information into the Windows registry and update the IdleThread value to 1. Beware:
Changing this setting may cause the Editor to crash when doing a right-click scrub so please contact
Customer Support before making this change. Another more minor drawback is that the Windows Task
Manager Performance Window will always indicate 100% CPU Usage when WaveFrame/7 is running even
if it snot true. DO NOT install this patch if you do not see DSP(0) errors.

Merging identified a problem that could cause sync problems on some systems. All WF7 customers
received atechnical memo about thisin February. Essentially they uncovered some problemsin the
circuitry extracting Video sync at high internal PC temperature. This was a consequence of trying to
improve the HDTV sync extraction by changing aresistor value. The problem appears when the ambient
internal PC temperature next to the Mykerinos board exceeds 55 degrees Celsius. This potentially affects a
series of Mykerinos cards with specific serial numbersin the range of 10800 (included) to 11600 (included)
that have resistor R108 with avalue of 270kOhm. All recent Mykerinos boards starting with serial number
11601 and higher already have the fix before leaving the manufacturer. This does not affect boards with
serial numbers less than 10800. Please check your Mykerinos serial number, even if you have

not experienced any sync or lock issues. This can be found in the VS3 Control Panel (Start..Programs..V S3
Runtime). Check the Board Info tab and look under Serial Number. If it isin the range listed above, then it
should be fixed if you are seeing the problems. If you have not yet had any sync issues, we only
recommend you get it fixed, but it is not required. We would prefer you arrange to send your card(s) to
Advanced Systems Group (if not in Europe) or to Merging Switzerland (if in Europe) for this modification
to be carried out. If you prefer and have some expertise in replacing surface mount resistors, ASG can send
you the 330 kOhms 0805 chip resistors to save time.

There is no check during WF6 or OpenTL Export for any missing WF7 sounds. You should do thisin
advance of any export by using the new View..Project Sounds tool in Project Browser or check the reel in
the Editor.

Read these links for some info on hot-swapping and using Windows 2000 removabl e drives:
http://support.microsoft.com/support/kb/articles/Q244/9/19.ASP
http://support.microsoft.com/support/kb/articles/Q288/8/99.ASP
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http://support.microsoft.com/support/kb/articles/Q266/7/04.ASP
http://msdn.microsoft.com/library/backgrnd/html/enterstor.htm

Read this for more info on Windows 2000 backup and CDR/R drives:
http://support.mcrosoft.com support/kb/articles/ Q62/0/06. ASP

Sometimes opening a ‘saved’ mixer state can cause 1/0O problems in mixer and/or editor and aso cause
auto-punch recording problems. We are currently working on al mixer issues.

The Track Rack Add Track operation fails for volumes that have an alias number of 100 or higher. Please
limit your volume numbersto 99 if you have that many online.

Logging on to Windows 2000 as a standard, restricted user or Guest will prevent the V S3 engine from
running which means WF7 will not launch. Y ou need to log on as an Administrator or Power User to run
WF7. There may be away around this by assigning certain permissions to standard, restricted users, so you
are encouraged to research thisin Windows 2000 materials or ask the experts. Many other applications are
like this and do not run properly when standard users are logged in.

Since the Editor’ s players/voices/resources can dynamically change from track to track, the mixer strips and
Editor tracks can get misaligned on rare occasions. This may be first seen in adding tracks to a layout and
noticing that solo buttonsin mixer do not always correspond with track solo states. Thisisavery
intermittent bug. We are currently working on all mixer issues.

When using “ Auto-convert when creating a WF7 volume” in the Sound Preferences dialog, the converted
and remaining source files do not end up in the database and aren’t seen in SS (but are in

the Windows folder). Avoid using this one setting in each sound file tab or dismount and refresh the
volume after the original volume creation.

If you prefer the immediate Play behavior when right-clicking a sound in Sound Selector (asin WF6), edit
thisline in wavefrm.ini under the [SoundSel ector] section so it says: RightClickMenu=0 (Defaultis1,
which enables the pop-up menu that includes Play, Stop, Copy, Move, Delete etc).

Lay-in conversions of SD2 files do not always show waveform. Dismount, refresh and remount these
affected files' volume(s) and waveforms will appear.

WF/7 Volumes on aMac drive for SDII/AIFF file support: Although we support the conversion of SDII and
AIFF filesto WF7 format, creating a WF7 volume on a Macintosh-formatted drive may not work properly.
Y ou may also get errors when laying in (and converting) SD2 files from the Sound Selector.

The System Status (error) window does not automatically come into focus when errors are reported after
Editor isrunning and it should so that the user is notified of any missing sounds due to volume changes, etc.
It is advisable to check this window after volume mounts and dismounts by using SHIFT-F11 to re-swap
tracks or just close and re-launch Editor, both which will prompt the status screen. If you have a sound
card, windows can be set to play a default sound when output is sent to thiswindow. Y ou can also use the
View..Project Sounds tool in the Project Browser to check for missing sounds.

Although the Sound Selector will allow you to view most database fields, altering the contents of many of
them is not allowed and you will be prevented from doing so. Fields such as Start Time, End Time,
Resolution, Sample Rate, Number of Channels, Channel and any others having to do with inherent
attributes of a sound file cannot be changed. Y ou can change Name, Library, Description, Comment,
Production and afew others. Remember, if asound fileis currently in atrack you can use view current to
change its name, library, description and/or comments.

Sometimes when launching Edit from Assemble after doing an assembly at least one track may bein an
input state even though it should not be and the input button is off. Toggle the “record arm” button twice
(on & off) to return the affected tracks to their proper state.
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OMF Import from a Mac CD works, aslong as resource forks are available on the CD. Some CD burning
packages may produce an extended Mac format on the CD that MacDrive may not be able to trandate. We
require using MacDrive version 4.04 or later to addressthisissue. It is recommended to use the standard
Mac format when creating CD’ s with MacDrive versions prior to 4.04.

The Spotting Rack’s Import command is incorrectly running the Track Rack Import routine. Please do not
useit here.

The Spotting Sheet’ s method of exporting and importing itself is currently limited to floppy disc (a
holdover from earlier WF6 versions). Thislimitation will be removed in afuture version.

Although you can access the Mixer wizard by right-clicking the mixer and choosing Settings..Wizard, we
do not recommend using it even though it should not crash the application. Thereis no way to completely
disable this right now.

The Mixer right-click menu Settings..Auto-Connect will reset your routing settings in the Mixer and they
will not match the Editor. Please do not use this function.

Renaming a sound file that exists across more than one mounted volume is not allowed due to duplicate
UFN issuesin the main database. Doing so will not make the change. Y ou must dismount those volumes
that include the duplicates and then do the rename.

Avoid creating Projects, Episodes and Reels with aperiod (.) or leading space character in the name until
we address some errors thiswill cause. Also, do not use the space character as the only character.

Itisstill required to close Edit before you delete, rename or move files in the Sound Selector (database).
Most Delete and Rename operations will be prevented and you will see a sharing violation warning of some
kind. You should use View Current to rename sounds when the Editor is running. Aswith any Windows
application you cannot make certain changes to files when they are open and this may be the caseif Editor
isrunning. We are working on this area and hope to have final fixes and ruleslater. Please report any
problems with these operations to Customer Support immediately.

It is not recommended to run any other memory-intensive applications while using WF7. Doing so may
cause system slow-down or a crash. Thisincludes background applications such as anti-virus programs and
especially those routines that access hard drives automatically.

Due to Windows file system requirements, it is currently not possible to have sound files with the exact
same name within avolume. Thisis achange from WaveFrame 6 so please adhere to thisrule. Renaming
a sound with the exact name of another filein that volume will not be recorded in the database and a
warning will appear. Files across volumes can have the same name.
It isstill the case that the WF file system does not allow duplicate sound files (same UFN) within avolume
regardless of their name. Our Volume Manager will filter out any duplicate sound files (UFN‘s) when you
create and mount volumes.
Flit and Duplicate functions are only supported for stereo and mono files.
It is not recommended to lay-in tracks from a CDROM due to severe performance limitations of this media
type and some other read-only volume bugs. Doing so will cause system slowdown and possible crashes.
Limit CD usage to browsing and copying to awritable volume.
Changes made to the contents of ANY mounted or dismounted WF volumes outside of the software (i.e. in
Windows Explorer) will not be reflected in the database and may cause database corruption. If you do need
to add or subtract files after the parent folders have been created as WF volumes, perform the stepslisted in
the Volume Manager section of the Getting Started Guide or manual. In the event of a corruption you may
get one of the following errors:
“NF 7 has caused errors’

“ACTOR 32P has caused errors’
These errors may prevent the user from starting WaveFrame/7, or from loading a particular project. Thisis
not aresult of abug within the Waveframe application. Should you get such as message proceed as
follows:
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Reboot the PC into windows

Use Windows “Search” across all LOCAL drivesto find and DELETE any files with these
suffixes: *.map, *.wfd, and *.wfdir. (Be sure that you do not have any networks drives
containing volumes mounted on your desktop.)

Rename the directory “C:\UDD” to “C:\OLDUDD”

Restart WF7 System...the application will act asif it isreinstalling the software, actually itis
creating anew UDD directory.

Open “Volume Manager” and use “New Volume” to re-create your sound volumes where
needed, then mount those volumes

Open “Project” and use “New/Edit” to create a new project.

Open “Project” and use “Browser” , then “Import” the “WF7 Project”...navigate to
C:\OLDUDD\Projects and use “OK”.

Import whatever projects you need into your new UDD.

Restart “Editor” and go back to work.
This processtypically takes about 10-15 minutes.

Waveform display will be on by default and is noticeably faster than in previous versions.

Waveform datais stored in the sound file itself and is created during volume create, during lay-
in conversion and at the end of arecording..

Y ou will find that Windows 2000 is a very stable operating system and our application’s stability

1-
2-

3-

benefits from this. Only in rare instances will you have to reboot your system. If you do crash
any of the WF apps, you can do the following:

If the apps will not close, use CTRL-ALT-DELETE and click on the Win2000 Task Manager.

Y ou can first choose any or al of the 3 WF apps (WaveFrame System, Mixer, Editor) under
Applications and End Task.

If the Editor was running and had crashed, go to Processes and select ntvdm.exe and “End
Process’. Thiswill close down the 16-bit processes.

By performing these steps you will not haveto reboot. You can then just restart the WF  apps
as described above.

OMF Export notes

After exporting to OMF, you will need to use either DigiTranslator or Avid’'s OMFToal to then import
into ProTools. It ishighly recommended to use the latest version of DigiTrandator to get the best
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results going from WF7 to ProTools. Use of the free OMFT ool may produce incorrect resultsin
ProTools.

Avid'sOMF Tool Kit does not support 24 bit. Therefore we cannot offer export to encapsulated OMF
24 bit because no one will be able to read it.

DigiTrandator 1.0 (current version) and OMFTool do not support 24 bit for either direction. Therefore
we now support OMF export with transglation from 24 bit to 16 bit. Supposedly DigiTranslator 2.0 (just
recently released) will support 24 bit.

ProTools cannot support mixed files of 24 and 16 bit. A ProTools project must be all 16 bit or all 24 bit
files. Therefore, if the project contains any files with 24 bit depth, an attempt to export to OMF as
encapsulated will produce a dialog which explains that the user must start the export again as separate
mediafiles.

Thereisanew set of radio buttons for OMF export where the user can choose to: convert all filesto 16
bit (so they can be used by DigiTranslator and Avid), convert all filesto 24 bit (as ProTools can not
support mixed bit depths), or leave filesin original depth (at user’srisk). See Getting Started guide for
more details.

OMFTool (AVID’sfreetrangdator) will not work with WaveFrame/7 generated OMF files with

exter nal media because OMFT ool has problems reading Macintosh locators made on a PC. Therefore
werequire DigiTranslator for conversion of WaveFrame generated external media OMF for ProTools
import. DigiTranslator can read our external media OMF files and Media Filesjust fine. Also, external
media files are required for projects over 2 Gigabytesin size.

DigiTrandator does not properly report 44056 or 47952 OMF projects as such. It will most likely
display the nominal rates even though your export might have been at one of the pull-down rates. Once
the conversion to ProTools is done, the project should look and play properly in ProTools.

Export using external media does not require a Macintosh formatted disk and MacDrive software on the
WaveFrame, but this arecommended practice to guarantee compatibility with importing this OMF
session on aMacintosh. .

Export using external mediawill truncate any sound file names longer than 31 characters due to Mac
file system limitations.

Although it islisted, we do not yet support 23.97 FPS for exports.

OMF Export using external mediawill place converted AIFF mediaat the root level of the target
volume. Use the Optional Destination MediaFiles Folder field in the export dialog to select a specific
folder. The default selection for separate mediafiles folder will be improved later.

Although you can use either export mode for eventual usein Merging's Pyramix (and FrameWorks),
Legacy Mode guarantees levels when imported into v4. Until Merging implements MC10 imports, do
not use OMF MC10 to export OMF for FW/Pyramix.

Thereis no method in OMF 2 for trand ating asymmetrical event crossfades created in WFH/7
(overlapping events). The exported OMF project will instead contain a separate track to properly
realize this effect when it occurs across events; thisis how Avid Media Composer and TransAudio
Pipelinedoit.

FrameWorks/Pyramix does not yet properly handle NTSC projects with pull-down media. Importing
an OMF file created in WF/7 from a 44056 or 47952 project will import into FW/Pyramix but the
mediawill only play at 44100 or 48000 on that system. See the FrameWorks/Pyramix documentation
or contact Merging support for more information.

Symmetrical crossfades and standard fade up and down from/to silence is supported, including levels
and ramps.

Export isonly to the OMF 2 format. OMF 1 is not planned for OMF Export.

Exports of projects with sounds that use pull-down rates may not be usable on Avid Media Composer
versions earlier than 10 due to limitations on that platform.



Exporting with 24 fps set may create a project that is not usable on the Avid pre-version 10 Media
Composer or other platforms that only support NTSC rates. Avid supports rational frame rates as
follows: 30/1, 2997/100, 30000/1001, 25/1. Avid supports adrop frame flag for NTSC rates.

If OMF MC10 Mode is used and subsequently opened in aversion 7 or 8 Avid, no event level
information will be translated. Use the OMF Legacy Mode (pre-M C 10) for any OMF exports that will
beusedinMC 7 or 8.

It is not recommended to use the OMF Legacy Mode for exports that will go to Avid v10 systems. This
has yet to be fully tested so this rule may change.

OMF Import Notes

- If asound was already imported (as determined by the OMF UID contained inside a searched UFN’s
file) the file import will be skipped and no prompting will be done, even if Prompt is checked. The
check to seeif the file was already imported goes over all mounted volumes, not just the selected
import volume.
If auser attempts to import into an already existing project name, they will be prompted for a unique
name unless “ Add to Existing Project” is checked.
Selecting “Add to Existing Project” will bring up a project browser each time. The selected project
name will appear in the “Destination WF/7 Project” edit box and that edit box will be grayed out. If
you then check “ Create New Project” the project name will remain and the edit box will be enabled
again. Thisisuseful for browsing for similar project names. The user can then edit the project name to
make a unique new one that is similar to an existing name.
When the “Import OMF Project” dialog first comes up, the OMF project name (derived from the file
name if a project nameis not specified inside the project) will be in the “Destination WF/7 Project” edit
box. If aproject of that name already exists, then a derived name will be automatically entered by
appending _1 or whatever is needed to make it unique.
If “Overwrite Existing Tracks” is not checked, an attempt will be made to check for name duplication
between the imported project and the existing project. The user will be warned if this attempted check
finds duplicated tracks. Because OMF import must derive track names at times, this check does not
find al duplicates. In this happens and there are duplicated track names, those tracks are not imported
(import is skipped without warning) unless “Overwrite Tracks’ is checked. Inthat case, duplicated
tracks are erased before replacement and therefore they are essentially overwritten.
When “Add to Existing Project” is checked, the projects Episode(s)(if any), Reel(s) and Dub(s) arein
the combo boxes and the user can select those before importing. Changing Reel, for example, will
display a new set of Dub(s) corresponding to that Reel for selection. Thefirst oneisautomatically
selected but the user can select another Dub. The same holds for Episode selection.
The “OMF Tracks to Import” and “ Referenced Sound Files’ list boxes are
implemented and working between themselves. Selecting itemsin either box will highlight the
corresponding items in the other box, but removing selected tracks from the import list will not be
implemented until afuture version.
The Sample Size conversion routine is not yet implemented. Sounds will be converted using their
original sample size.
Sometimes the log file generated after the import can be misleading in how it reports the project sample
rate and start time. The sample rate listed may be based on the first sound file/event’ s rate and not
necessarily the correct rate for the whole project. It isimportant to verify the correct project settings
since the log file does not always tell the whol e story.
If an OMF project is re-imported or added into an existing project, and the original imported project no
longer exists in WF7, the sound files may be re-imported creating duplicates in the database. Thisis
not a problem other than a source of possible confusion. This behavior cannot be avoided because of
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the sometimes-difficult correlation between the original OMF sound files and the UFN stamp given to
conversions within WF7.

Import looks for external mediain afolder off the directory where the OMF fileis. The directory name
should be MediaFile where * can be anything including spaces. Usually the external mediaisin a
directory called OMFI MediaFiles or such but the only gating factor is that MediaFile should be in the
name. Using this syntax will allow OMF Import to find media without asking the user for location.
Some OMF 1 projects (such as those from the Tascam MM R8 dubber or TransAudio Pipeline software)
contain minimal fade/ramp information at best and sometimes no levels. Imports of these cannot create
or expand on this data.

All the fade files are imported along with the project. This makes lots of little files as well as the larger
ones. When we import the composition, we do not put the fade files into the tracks because the fade
information is in the ramps in WaveFrame/7. Therefore, many tiny little fade files will be in the target
sound volume, sort of as orphaned files and not in any track in the composition. These fade files could
be added later if you really need them by refreshing the volume.

ProTools is not capable of rendering (playing) cross fades, ramps and levels in real time. Therefore
ProTools renders “fade files” so these effects can be played in real time. When a ProTools project is
exported to OMF these “effects’ called levels, ramps and cross fades are exported as “fade files’. The
actual effect information, such as level gain and ramp information, is not exported along with the “fade
files’. Therefore, once exported, this important “effect” information is lost and the only data is the
collection of “fade files”. AVID exports are different, in that, even though AVID exports include fade
files, the level and ramp and cross fade information is included in the export. Therefore WaveFrame/7
OMF import can ignore the fade files and simply use the original sound files and ramp and level
information. Unfortunately, the fade files in Digidesign exports are the only information in the project
and cannot be discarded or ignored without intelligent intervention. The WaveFrame/7 editor would
have to throw them away manually and individually and intelligently extend the ramp in the Editor to
replace the manually discarded fade files. This is too far beyond the limitations of what our OMF
import can or should handle. It is unfortunate that DigiTranslator is not smart enough to also include
the ramp, cross fade and level information as AVID does in AVID exports. Therefore, athough
WaveFrame/7 can ignore fade files in AVID exported projects, the fade files must be included in
DigiTrandator exported files.

We have implemented a partial correlation between the OMF unique ID and the WaveFrame/7 UFN.
Therefore, if the same file is imported again, it is possible that WF7 will see that the file was already
imported and skip importing it again. This is useful for testing because the subsequent imports of the
same OMF go much faster if all the audio data does not need to be copied again. We still need to
convert all mediafrom AIFF or SDII to BWF format and then read all data again to insert waveforms.
Import does not handle gains greater than unity.

OMF Import/Export — If the levels are specified for the sound file instead of the track, we do not pre-
condition the track or sound.

For a partial list of OMF project platforms tested for import/export, see the file ‘OMF-Tested
Platforms.txt’ in the Misc folder of the installation set. Thisisalist of most of the OMF platforms and
versions we have tested with.

PLEASE REPORT ANY BUGS TO michael@waveframe.com
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